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All other company or product names are trademarks of their respective 
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Technical support and information are available at request from our 
Support Helpdesk or via our Support web site. 

 

 

Technical Support e-mail: 

support@modelcreator.com 

 

Support web site: 

http://www.modelcreator.com/index.php?s=content&p=support 
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Introduction 

ERCreator is a price-competitive and productive ER-Diagram tool for data 
modeling and database design. 

It lets you design and document your datamodel in a database diagram 
(ERD) in an easy-learned diagram tool. You can print reports and 
database diagrams and even check the datamodel for consistency. 

In addition, ERCreator Database Edition can generate database scripts 
for creating the database entities either via DDL files or connect to the 
database with the ODBC interface for easy maintenance. 

With ERCreator Analyzer as well as Database Edition, existing databases 
can be reverse engineered via the ODBC interface. 

The tool is easy to use - and can even be used in a tree-view mode 
where the mouse is not even necesary for input. 

 

Key features 

The ERCreator toolset supports the most essential functions for creating 
and maintaining data models, including: 

� � Create and maintain entities.  

� � Create and maintain attributes.  

� � Create and maintain relations between entities. 

� � Check the model for consistency. 

� � support for Referential Integrity actions (depending on the DBMS). 

� � Command-line interface 

� � Generate the physical database structure in Database Definition 
Language (DDL) files or directly in the DBMS via ODBC.  

� � Reverse engineer existing databases via an ODBC connection. 

� � Generate documentation on the logical datamodel in a variety of 
reports formatted as text as well as HTML-based.  

� � Save the datamodel in an open XML-based file format. 

This guide help you getting started with ERCreator. It will give you an 
overview of the tool, so you get a better understanding of the posibilities - 
and are able to take advantage of these. 
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Installation 

When installing ERCreator, please follow this instruction: 

 

Upgrade 

When upgrading ERCreator, please: 

1 Backup your models to a safe place. 

2 Uninstall ERCreator with the uninstall option. 

3 Install the new version of ERCreator (follow the New installation 
description). 

 

New installation 

ERCreator has a setup program for easy installation: 

1 Run the ERCreator installer, ercxxxxx.exe (xxxxx depends on the 
actual version of ERCreator). 

2 View the License Agreement and Readme information. 

3 Choose the destination directory. 

4 Select the Setup type. 

5 Select the Program group. 

6 Confirm to finish the installation. 

 

Starting ERCreator 

This part gives you a brief introduction to the basic tasks in ERCreator. 

 

Using Tips of the day 

When starting ERCreator for the first time, you will see the Tips of the 
Day dialog. These tips can be a great help as long as you are new to 
ERCreator. 

Tips of the Day can be turned off anytime by unchecking Show Tips on 
StartUp. If you wants to turn the Tips of the Day back on, please select 
Tips of the Day… in the Help menu and check Show Tips on StartUp. 

 

Creating the first model 

The model is the 'container' of all the elements in the datamodel, and 
before you can start working with ERCreator, you need to create a new 
model: 

1 Select New in the File menu. 

2 Specify the name of the new model in the Model Proporties dialog. 
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3 Enter a short description (optional). 

4 Specify the Schema name to optionally prefix database statements 
with the schema name. 

5 Select OK or press <Enter>. 

Tip The toolbutton New or the key sequence <Ctrl><N> can be used as a 
shortcut. 

 

 

 

 

 

 

 

 

 

 

 

Saving the model 

You should save your model to a file for keeping your model in a 
permanent store: 

1 Select Save or Save As in the File menu. 

2 If the file name is required, specify this in the Save As dialog. 

3 Select Save or press <Enter>. 

Tip ERCreator will prompt you to confirm before overwriting the existing 
file, if you specify an existing filename in the Save As dialog. 

The toolbutton Save or the key sequence <Ctrl><S> can be used as a 
shortcut. 
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Overview of the user interface 

The datamodeling task can be performed from the Datamodel 
Diagrammer or the Datamodel Explorer which both represent the logical 
view of the model. 

 
The physical view of the model is represented in the Database Explorer 
tool in ERCreator. 

 
The views can be selected and showed individually – or they can all be 
visible at the same time. Views can be shown using the View menu, 
Views can be made active using the Window menu. 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

Datamodel Diagrammer 

Datamodel Explorer 

Database Explorer 
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Customizing ERCreator settings 

ERCreator can be configurated to fit the way the user prefer to work. 

 

 

 

 

 

 

 

 

 

 

 

 

The most important settings are: 

 
Use logical name as physical name when empty 

Suppresses the prompting from ERCreater when no physical name is 
specified. 

 
Prefix transformed key attributes with PK (or FK) 

Makes ERCreator prefix primary key attributes with PK_, PK1 or FK_, 
FK1 etc. depending on the relation type. 

 
Layout Tab: Datamodel Diagrammer – (buttons) 

The look of the datamodel diagram can be manipulated with the buttons 
in the Datamodel Diagrammer group. This includes the font and colors 
used. 

 
Layout Tab: Report – Generate as ... 

Specify the prefered report format. 

 
File Locations Tab:  

Specify the default file location for the different file types (model file, ddl 
file and report files). 

 

Getting help 

ERCreator contains online help with usefull information to every part of 
the application. Just press F1 or select the Help button or menu item. 
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Working with ERCreator 

When you are aware of the different views in ERCreator, it is time to start 
working with the tool. 

 

Opening a model 

ERCreator uses the Common Dialogs in Windows to support the basic 
file-handling functions: opening and saving of the models. 

In addition, you can drag and drop an ERCreator file on the ERCreator 
icon – or you can start ERCreator from the command line and specify the 
command line options. 

 

Creating Entities 

Creating and maintaining the individual entities is handled in the Entity 
Properties dialog. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To create an entity, please: 

1 Select Add Entity in the Datamodel menu. 

2 Specify the name of the new entity in the Entity Proporties dialog. 

3 Specify the physical name or leave this field empty to let ERCreator 
reuse the name as the physical name. If you check No 
implementation the physical name will be disabled and the entity will 
not be transformed to a table in the Database Generation process. 

4 Select OK or press <Enter>. 
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Tip The toolbutton Add entity or the right-click pop-up menu can be 
used as a shortcut. Check the option Keep dialog open if you wish to 
create several new entities. 

 

Creating attributes 

Creating and maintaining the attributes on any entity is done in the 
Attribute properties dialog. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To create an attribute: 

1 Select the entity that should own the new attribute. 

2 Select Add Attribute in the Datamodel menu (or select New from the 
Attributes Tab in the Entity Properties dialog). 

3 Specify the name of the new attribute in the Attribute Proporties 
dialog. 

4 Specify the type of the new attribute. 

5 Specify the physical name or leave this field empty to let ERCreator 
reuse the name as the physical name. If the entity, that owns the new 
attribute is a No implementation entity, the physical name of the 
attribute will be disabled. 

6 Select OK or press <Enter>. 

Tip The toolbutton Add attribute or the right-click pop-up menu can be 
used as a shortcut. Check the option Keep dialog open if you wish to 
create several new attributes. 
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Creating relations 

Creating and maintaining relations between existing entities is done in the 
Relation Properties dialog. 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1 Select Add Relation in the Datamodel menu (or select New from the 
Relations Tab in the Entity Properties dialog). 

2 Specify the From entity and the To entity of the new relation in the 
Relation Proporties dialog. 

3 Specify whether the new relation is identifying. 

4 Specify the Role and Cardinality of the new relation. 

5 For relations with Many-many cardinality, you can specify the Physical 
name – or leave it empty to let ERCreator construct a physical name. 

6 Select OK or press <Enter>. 

 

Tip If one or both entities are selected when selecting this command, 
ERCreator will fill-in the entity fields in the Relation Proporties dialog. 

The toolbutton Add relation or the right-click pop-up menu can be used 
as a shortcut. 
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Working with the Diagrammer view 

You can also add entities and relations by pressing the tool-button for the 
relevant object. For details on the individual actions, please see Working 
with ERCreator earlier in this guide. 

Adding Entities and Attributes 

Add an entity by pressing the entity tool-button and move the 
mouse (mouse cursor has changed) to the place in the model and press 
the left mouse button. The dialog described in previous chapter will 
appear for entering of further details. When an entity is selected, you can 
add attributes by pressing the atribute tool-button:  

Adding Relations 

Add a relation by pressing the relation tool-button; note that the 
mouse cursor changes and the digit ”1” is part of that cursor, this 
means you can select the first entity that the relation is attached to.  

 

Move the cursor to the entity and press mouse button 1; now the cursor 
changes and the digit ”2” is part of that cursor, you can now select the 
second entity that the relation is attached to. After selecting the second 
entity the normal relation dialog described in previous chapter will appear 
for entering of further details. 

Tip If an entity is selected when the Add relation command is selected, it 
is only necessary to specify the second entity of the relation. 

Rearranging or alligning entities 

You can rearrange the figures in the diagram by moving them around. 
Move the mouse cursor to an entity and press the left mouse button and 
keep it down; you can now move the entity around. You can likewise 
move the mouse cursor to a relation and drag it as you want.  

 

 

 

 

You can select a set of entities and using the alignment tool-button to 
align them or choose the space evenly menu to space them evenly. For a 
complete rearranging of all elements in the model, please use the 
Arrange All option. 

Clipboard 

You can also use the selection of a set of figures to copy the bitmap to 
the clipboard for documentation purposes i.e. a text-processing tool. 
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Checking your model for consistency 

ERCreator has a built-in validation tool for for checking the consistency in 
a model: 

1 Select Consistency Check in the Datamodel menu. 

2 The result of the check is displayed in the Consistency Check dialog. 
If errors or warnings are found, they are listed here. 

3 Select OK or press <Enter> to close the Consistency Check dialog. 

 

 

 

 

 

 

 

 

 

 

Tip The toolbutton Consistency Check can be used as a shortcut. 

 

Generating reports 

ERCreator can generate documentation reports in either text or HTML 
format, depending on the settings. To generate a report: 

1 Select the appropriate report in the Report menu. 

2 Specify the report file name in the Save report dialog. 

3 Select Save or press <Enter>. 

4 ERCreator shows the report in a text editor window. 

Tip ERCreator will prompt you to confirm before overwriting the existing 
file, if you specify an existing file name in the Save report dialog. 
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Connecting to an ODBC datasource 

The ODBC Data Source dialog is used to connect to a DBMS via an 
existing ODBC Data Source1. 

 

 

 

 

 

 

 

 

 

 

Depending on the configuration of the ODBC data source, the user name 
and password should be specified. 

The schema name is optional. 

Tip When ERCreator are connected to an ODBC data source, the 
Connect toolbutton is disabled and the text “Connected” is displayed in 
the statusbar. 

 

Generating a database 

The physical database is generated via the Generate Database dialog. 
ERCreator will check the model for consistency before generating the 
database. If the consistency check finds critical errors in the model, you 
will not be able to generate the database. 

To generate the database (or preview the DDL) do the following: 

1 Select Generate Database in the Datamodel menu. 

2 If the model is consistent, the Generate Database dialog appears. 

3 Select the generate options. 

4 Select View DDL to preview the DDL or select Generate to create the 
database right away. 

5 If you selected View DDL, please specify the DDL filename in the 
Save DDL dialog and select Save or press <Enter>. 

6 If you selected Generate, ERCreator will prompt you to connect to the 
ODBC datasource if there is no curent ODBC connection. 

 

 

                                                
1 Created by the user in the Microsoft ODBC Administrator application. 
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If you specify an existing file name in the Save DDL dialog, ERCreator 
will prompt you to confirm before overwriting the existing file. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

7 Depending on your choice, ERCreator will either show the DDL in a 
text editor window or show the result of the generate proces. 

 

 

 

 

 

 

 

 

 

 

Tip The toolbutton Generate Database can be used as a shortcut. 

 

Reverse engineering an existing database 
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The reverse engineering process reads the database structure from a 
connected ODBC data source and creates a logical datamodel from that. 
In this transformation, foreign key information in the database is changed 
to relations in the datamodel if possible. 

The transformed datamodel can be seen in either the Datamodel 
Diagrammer or the Datamodel Explorer. If you want to view the physical 
(transformed) database structure, please use Database Explorer in 
ERCreator. 

 

To run the reverse engineering: 

1 Select Reverse Engineer in the Datamodel menu. 

2 If you are not connected to an ODBC data source, the ODBC 
Connect dialog is shown, othervise the reverse engineering starts. 

3 If the ODBC data source does not return information about the 
relations, ERCreator will prompt for creating these from a built-in 
algorithm. 

4 ERCreator shows the reverse engineered datamodel. 

Tip The toolbutton Reverse Engineer can be used as a shortcut. 

 

Canceling operations 

When performing lengthy operations like reading from a file, generating a 
database or reverse engineering from an existing database, ERCreator 
displays a progress dialog: 

 

 

 

 

 

 

 

 

The operation can be cancelled from the dialog, but notice, that when 
generating a database, the tables that might have been created by the 
time of the interruption is not rolled back. You can perform a reverse 
engineering and subsequent database generation with the drop table 
option to remove these. 

 

Geting the work done fast 

ERCreator has some build-in features, that can speed up the work. If you 
want to speed your work up, you can: 

� � Use the Datamodel Explorer view, which let you create a datamodel 
without using the mouse. 
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� � Use the Keep dialog open option in the Entity properties dialog for 
creating multiples entity without closing the dialog. 

� � Use the Keep dialog open option in the Attribute properties dialog for 
creating multiples attributes within the current entity without closing 
the dialog. 

� � Use the shortcut keys or the right-click pop-up menu as often as 
possible. 

 

Support 

Technical support and information are available at request from our 
Support Helpdesk or via our Support web site. 

 

Technical Support e-mail: 

support@modelcreator.com 

 

Support web site: 

http://www.modelcreator.com/index.php?s=content&p=support 

 


